IT Essentials: PC Hardware and Software v4.1

Chapter 5 - Lab/Student

5.5.3 Optional Lab: Managing Administrative Settings and Snap-

ins in Windows Vista

Introduction

Print and complete this lab.

In this lab, you will use administrative tools to monitor system resources. You will also build a
custom console to manage storage devices.

Recommended Equipment
The following equipment is required for this exercise:
¢ A computer running Windows Vista

¢ Internet access

Step 1

Log on to the computer as an administrator.

Navigate to the “Network and Sharing Center” window by clicking Start > Network >
Network and Sharing Center. Click Manage network connections in the left pane

below Tasks.

=EEEE]

Tasks

View computers and devices
Connect to a network

Set up a connection or network
Manage network connections

Diagnose and repair

See also

!n?_c'i:net Options

Windows Firewall

e :
OU -'-|1~ + Control Panel » MNetwork and Sharing Center

Network and Sharing Center

ﬁ ! 3
4 .
JOHN-PC

(This computer)

__E_‘ MNetwork (Private network)

- | 5 | | Search

Access Local and Internet

Connection Local Area Connection

|2 Sharing and Discovery

Network discovery © On
File sharing < Off
Public folder sharing © Off
Printer sharing © Off
Password protected sharing @ On
Media sharing @ Off

Show me all the files and folders I am sharing

Show me all the shared network folders on this computer

P
@.

View full map

Internet

Customize

View status

m

4
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Reduce the size of the “Network Connections” window. Leave this window open.

v|;@ « Metwork Cennections » - |‘1~ | | Search L |

‘ Organize
Name Status Device Mame Connectivity MNetwork Category Owner »
LAN or High-Speed Internet (1) ~

=~ | Local Area Connection
r _ Metwork

Czd Intel(R) PRC/1000 MT Metw...

Step 2

Navigate to the “Control Panel” window by clicking Start > Control Panel. If not in
Classic View select this interface. Double-click the Administrative Tools icon.

;—‘e v v Control Panel » - | &,| |Searrh L |
Name Catego =
Control Panel Home iy T
- -_:\.1 a : —
*  Classic View z o= }
ﬁ -{q = @ i;& Eﬂ
Add Administrativ AutoPlay  Backup and Coler Date and Default Device
Hardware e Tools [:} Restore .. Management Time Programs Manager
FZ= v :
Ease of Folder Fonts Game Indexing Internet  ISCS[Initiator  Keyboard
Acce.. Opticns Contrellers Opticns Opticns
LA - =
P B )P/ ¥R
- = — o e
Mouse MNetwark and  Offline Files Penand  People Mear Pedformance Personaliz.. Phoneand
Sharing Ce.. Input Devices Me Informatio.. Modem ...
£ — B r/_ =
14 \ *’
@ : m '(‘1_‘ )
= % 3 “ay @ @
Power Printers Problem Programs  Regicnal and Scanners and  Security Sound
Opticns Reports a..  and Features Language..  Cameras Center
- ) B -
L | = & 1
Speech Sync Center System Tablet PC Taskbar and Textto User WVhlware
Recogniti.. Settings Start Menu Speech Accounts Tools
== - [ o s - 4 = == ¥
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Double-click the Reliability and Performance Monitor icon.
If the “User Account Control” window appears, click Continue.

-E-EH |
%v| 7 » Control Panel » Administrative Tools - |‘, ‘ | Search L |
‘ Organize ¥ g@f Views ~ [B Open (@ Bumn
Esvorite Finks Name’ Date medified Type Size
E| Documents ‘i' =il
E‘. Pictures J . |
B‘ Music Computer Data Sources  Event Viewer  iSCSIInitiator Local Memo
IManagement (ODBC) Securi., Diagnosti..

% Recently Changed

IB Searches 3 i \_',,;' ; i ‘"L\\ g
) Public 7 S T |IE_)
e .y ot

Print Relizbility Services System Tazk Windows
IManagement and Configurat... Scheduler Firewall wi...
Performance

Monitor h

Folders ~

Reliability and Performance Monitor Date modified: 1/20/2008 7:43 PM
Shortcut Size: 1.58 KB
Date created: 11/2/2006 5:53 AM

Step 3
The “Reliability and Performance Monitor” window appears. Make sure the Performance
Monitor in the left pane is highlighted. Click the Freeze Display icon to stop the

recording.
| @Reﬁahil'ﬂy and Performance Monitor -E-@
@ File Action View Favorites Window Help B@E‘
ol AR I | @
@ Relizkility and Performance Performance Monitor
4 [ Monitoring Tools —
P E - | By 4
B8 Performance Menitor o= | E:a x 3 | = B ‘ ||!N.I|
) E= Reliability Moniter [ Freeze Display (Ctri+F) |
1+ [ Data Collector Sets 100
i [ Reports
80
60+
404
204
ol . .
1:32:42 PM 1:33:14 PM 1:33:44 PM 1:34:20 PM
Last | 5250 Average | 2801 Minimum | 0,000
Maximurm | 39,063 Duration | 1:40
Show Color Scale Counter Instance Parent  Object Computer
v

© 2007-2010, Cisco Systems, Inc. All rights reserved. Page 3



IT Essentials: PC Hardware and Software v4.1 Chapter 5 - Lab/Student

Right click the Performance Monitor menu bar, select Clear to clear the graph. Leave this
window open.

@ Reﬁabil'ny and Performance Monitor @
@ File Action View Favorites Window Help EEE
ol i =|H

4 [ Monitoring Tools

B8 Performance Menitor 3 IE v| # x 9? | = I:I ! ‘ I} Ibu |

== Reliability Monitor Add Counters.., B
1+ [ Data Collector Sets 100 Save Settings As...
i @ Reports

Save Image As..

804 Save Data As..

604 Zom To

Show Selected Counters
404 Hide Selected Counters
Scale Selected Counters

Remove All Counters

204
Properties...
0 |
1:32:42 PM 1:33:15 PM 1:33:45 PM 1:34:20 PM
e Average| oo [T A—
Maximum | --------- Duration | L40
Show Color  Scale Counter Instance Parent  Object Computer

M ——10  %ProcessorTime  Total - Processor  WOHN-PC

Step 4
Navigate to the “Administrative Tools” window by clicking Start > Control Panel >
Administrative Tools. Double-click the Services icon.
If the “User Account Control” window appears, click Continue.

%v[ v Contrel Panel » Administrative Tocls v.| Jv.,.._| |Sggn:h _{J_|

‘ Organize v @@ Views ~ [ Open (@ Bumn

Favorite Links Type Size

E| Documents =i .

E‘. Pictures L3 .

g Music Computer Data Sources  Event Viewer  i5CSlInitiator Local Memory

@ Recently Changed Managerment (ODBC) Securi... Diagnosti...
\l Yy

E Searches 3 P, :_',{;' ; ?_-- ""/:I:M :
)i Public - Uil . (G |
i ¢ |/

Print Reliability Services System Task Windows
Management  and Perfor... l}) Configurat... Scheduler Firewall wi...

Folders »~

Services Date modified: 1/20/2008 7:43 PM
Shertcut Size: 1.64 KB

- Date created: 11,/2/2006 5:53 AM
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Step 5
Expand the width of the “Services” window so you have a clear view of the content. Scroll
down in the right pane until you see the service Routing and Remote Access. Double
click Routing and Remote Access.

. Services [E=2EcH |5

File Actien View Help

e EEc= HE »annp

£ Services (Local) . Services (Local)
-
Routing and Remote Access Name Description Status Startup Type Log On As =
54 Protected Storage Provides protect.., Manual Local Syste...
Description: o oo B E R o E
Offers routing services to businesses Sk Quality Windows Audio Vid... Quality Window... IManual Local Service
in Iuc-al area an-cl \,\.pic\e-area n;twc‘;k‘ %% ReadyBoost Provides supper...  Started Automatic Local Syste...

environments. % Remote Access Auto Conn...  Crestes a conne... Manual Local Syste...
% Remote Access Connection... Manages dial-u...  Started Manual Local Syste...
% Remote Procedure Call (RPC) Serves astheen.,  Started Automatic Network 5... e
£ Remote Procedure Call (RP...  Manages the RP... Manual Network 5., |5|
. Remote Registry Enables remote .. Manual Local Service iIi
#3 Routing and Remote Access  Offers routing s... Disabled Local Syste...
5k Secondary Logon Enables starting ... Started Automatic Local Syste...
%5 Secure Socket Tunneling Pr... Provides suppor..  Started Manual Lecal Service
% Security Accounts Manager  The startup of t.. Started Automatic Local Syste...
%4 Security Center Monitors syste...  Started Automatic (D... Local Service
& Server Sunnaorts file nri.. Started Aitomatic | nral Suste... i

\Extemlec\j(Standardf

The “Routing and Remote Access Properties (Local Computer)” windows appears. In the
Startup type select Manual. Click Apply.

Reuting and Remote Access Properties (Local Computer) (=]

General | Log On | Recovery | Dependencies |

Service name: RemoteAzcess

Display name: Routing and Remote Access

Description: {Cffers routing services to businesses in local area -
and wide area network environments. -

Path to executable:

CAWindows'\system 32 avchost exe 4 netsves

Startup type: Manual X

Help me configurs service startup options.

Service status:  Stopped

Start Stop Pause Resum

L]

You can specify the statt parameters that apply when you start the service
from here.

[ ok ][ Gameel || ﬁpph’t\g

The Start button is now active; do not click the button yet. Leave this window open.
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Step 6

Position the following three windows so you can clearly see them at the same time for
steps 7 to 14: Network Connections, Routing and Remote Access Properties (Local

Computer), and Reliability and Performance Monitor.

[« [
O‘C) &« Hetwork Connections »

v [ 49 )] secrch »

Connectivity Cwner

Metwork Category

@ Reliability 2nd Performance Monitor

ez HE = Hm=

4 [ Monitoring Teols

@ File Action View Favorites Window Help

B Performance Moty LD ® B - X | EER| b M|

E=(EaE o
- 5] =]

= Reliability Moniter
i+ [ Data Collector Sets

Add Counters...

o

Save Settings As.
> L Reports Save Image As...
80 Save Data As
Clgar
60 nTo
Show Selected Counters
o Hide Selected Counters
Scale Selected Counters
Remove All Counters
20
Properties.
|
1:3242PM 13315 PM 1:3345 PM 1:34:20 PM
R = Average| - Minimum [ e
Maximum [ e Duration | 140
Show Color Scale  Counter Instance Parent  Object Computer

Routing and Remote Access Properties (Local Camputer}

Generl | Log On | Recoveny I Dependenciesl

Service name:  RemoteAccass

Display name: Routing and Remote Access

Description ers routing services to businesses in local area -
nd wide arsa netwaork environments. -

Path to executable:
C:\Windows'\system32\evchost exe 4 neteves

Startup type: [ Manual X

Help me configure service startup options.

Service status Stopped

Start Stop Pause Resume

“fou can specify the start parameters that apply when you start the service
from here.

Start parameters:

[ ok J[ camca || ﬂuper;
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Step 7

Click the “Performance” window so it is activated. Click the Unfreeze Display icon to
start the recording.

' @ keﬁaﬁi!ﬂy and Performance Monitor

= e e
@ File Action View Favorites Window Help lz“E"z‘
&= # w | H
4 :i Menitering Tools — =
D E- £ (B =
B8 Performance Monitor LA | E:h x f-? | 1= B ! ||_[QSH>|]|
. &= Reliability Menitor Unfreeze Display (Ctrl+F) h
1+ [y Data Collector Sets 100
i [ Reports
504
0 T .
1:32:42 PM 1:33:15 PM 1:33:45 PM 1:34:20 PM
Last[ —  -ee-eee- Average|  ---meee- Minimum [ --eeeeee
Ma)(|mum| --------- Duratlon| 1:40
Show Color Scale Counter Instance Parent  Ohbject Computer
¥ ——10  %ProcessorTime  Totel - Processor  \WOHN-PC

Step 8

Click the “Routing and Remote Access Properties (Local Computer)” window so it is
activated. To start the Service click Start.

A window with a progress bar appears.

[

=

Service Control @

Windows is attempting to start the following service on Local Computer...

Routing and Remaote Access

Cloze
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The “Routing and Remote Access Properties (Local Computer)” window now shows the

Stop and Pause button active. Leave this window open.

-

Reuting and Remote Access Properties (Local Computer) (==

General |Log On I Recovery I Dependencies|

Service name: FemoteAccess

Display name: Routing and Remote Access

Diescrption: &rs routing services to businesses in local area -
nd wide area network environments. -

Path to executable:
C A Windows system32'svchost exe 4 netsves

Startup type: Manual Bt

Help me configure service startup options.

Service status:  Started

Start l Stop l [ Fause l Resume

You can specify the start parameters that apply when you star the service
from hers.

Start parameters:

QK ] l Cancel Apphy

Step 9

Click the “Network Connections” window so it is activated. Press function key F5 to

refresh the content.

Search

| ||i ) |@ <« Metwork Connections »

By Organize ~ &= Views -

- 4|

Mame Status Device Mame Connectivity Metwork Category

Incoming (1)

|
h} Ne clients connected

LAM or High-5peed Internet (1)

-

L= Local Area Connection
> Network
GED Intel(R) PRO/LOO0 MT Metw...

Inceming Connections

Owner »

1. What changes appear in the right pane, after starting the Routing and Remote

Access service?
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Step 10
Click the “Routing and Remote Access Properties (Local Computer)” window so it is
activated. Click Stop.

Routing and Remote Access Preperties (Local Computer) [

General | Log On | Recovery | Dependencies |

Service name; RemoteAccess

Display name: Routing and Remote Access

Description:
nd wide area network environments.

Eﬂers routing services to businesses in local area <

-

Path to executable:
C:\Windows'system32'svchost exe 4 netsves

Startup type: Manual h

Help me configure service startup options.

Service status:  Started

Start l Stop ’ Fause ] Resume

“fou can specify the start parameters that apply when you start the service
from here,

Start paraneters:

QK ] ’ Cancel Apply

Step 11
Click the “Network Connections” window so it is activated.
e S
{ ||i = |@ <« Metwork Connecticns » = | 3 | Search e |

By Organize ~ o= Views -

MName Status Device Mame Connectivity Network Category Owner »
LAM or High-Speed Internet (1) ~

-'-h' Local Area Connection
o [etwork

‘-ﬁ:ﬁf Intel(R} PRO/L000 MT Metw...

2. What changes appear in the right pane, after stopping the Routing and Remote
Access service?
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Step 12

Click the “Performance” window so it is activated. Click the Freeze Display icon to stop
the recording.

@ File Action View Favorites Window Help

e 2@ 0=
4 ﬁ Menitoring Tools =
B8 Performance Moniter ? v| E} x g | = I:I q H—Ll
B Reliability Monitor e
» [ Data Collector Sets 100 | Freeze Display (Ctrl+F) |

B :‘ﬁ Reports

.,)é'.‘

==

50
0 %\/\/\/\ |
2:02:03 PM 2:02:35 PM 2:03:05 PM 2:03:42 PM
Last 0.375 Average 15104  Minimum 1.562
Maximum | 42188 Duration | 1:40
Computer

‘Show Color | Scale  Counter Instance Parent = Object
¥l ——— 10  ProcessorTime Totsl - Processor  \UDHN-PC

3. Which Counter is being recorded the most in the graph (hint: look at the graph color
and Counter color)?

Click the Change graph type drop down menu, select Report.

@ File Action \View Favorites Window Help

e 1EF D= H

4 [ Monitering Teols

BE Performance Moniter ;‘l:E]EI | 4‘ x y | = I:I " D D”

”,)&'.‘

BED

== Reliability Menitor v Line
2 3 Data Collector Sets 1004 Histogram bar
I m Reports fe
port
Ly

0
2:02:03 PM 2:02:35 PM 2:03:05 PM 2:03:42 PM
Last | 213438 Average | 18950 Minimum | 1.563
Maximum | 08438 Duration | 1:40
Show Color Scale  Counter Instance Parent  Object Computer

¥ ——10  ProcessorTime  Total .- Processor  \WOHN-PC
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The display changes to report view.

@ Reliability and Performance Monitor
@ File Action View Favorites Window Help

ol AR
@ Reliability and Performance
4 [ Menitoring Tools

B Performance Monitor

cI=Es
HEE

== Reliability Monitor
i+ [y Data Collector Sets \WJOHN-PC

Ir= Processor
2 Reports
o % Processor Time

_Total
23438

4. List the values of the counter.

Step 13

Click the “Routing and Remote Access Properties (Local Computer)” window so it is

activated. In the Startup type select Disabled. Click OK.

i l!a:'i.l.i-ing and Remote Access i’mpe"lt.is {Local Eomp;ltell}

General | Log On | Recovery | Dependencies|

Service name: RemoteAccess

Display name: Routing and Remote Access

d wide area network environments.

Path to executable:
CWindows system32\evchost exe 4 netsvece

Description: F)Vers routing services to businesses in local area
Iy

-

Startup type: [ Disabled

Help me configurs service startup options.

Service status:  Stopped

s ][ e

from hers.

| | Resume

fou can specify the start parameters that apply when you start the service

Start parameters:

[ ok h‘J[ Cancel | [ #pply
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Click the “Service” window so it is activated.

=3

File Action View Help

Hoz Ha »mun

'y

Services (Local)

Routing and Remote Access MNare Description Status Startup Type
S.e, Protected Storage Provides protect... Manual
Aol o] Quality Windows Audie Vid... Quality Window... Manual
Offers routing services to businesses
inllocalaressnd wide areanebiork eadyBoost Provides suppor... Started Automatic
environments, ‘0 Remote Access Auto Conn...  Creates a conne... Manual
-S‘,",RemuteAccEss Connection... Manages dial-u...  Started Manual
Sm Remote Procedure Call (RPC) Serves astheen.. Started Automatic
£\ Remote Procedure Call (RP... Manages the RP... Manual
£, Remote Registry Enables remote Manual

Q, Routing and Remote Access Disabled

Offers routing s

econdary Logen Enables starting ... Started Automatic
ecure Socket Tunneling Pr...  Provides suppor..  Started Manual
5 Security Accounts Manager  The startup of t..  Started Automatic
4, Security Center Monitors syste...  Started Automatic (D,
Ck Server Sunnorts file o Started  Automatic

-

Log On As

Local Syste..,
Local Service
Local Syste...
Local Syste...
Lecal Syste..
MNetwerk 5.
MNetwork ...
Local Service

Local Syste..,
Local Service
Local Syste..,
Local Service

| neal Suste.

Extended AStandard/

5. What is the Status and Startup Type for Routing and Remote Access?

Step 14
Click the “Performance” window so it is activated. Click the Unfreeze Display icon to
start the recording.

@ Reliability and Performance
4 :i Menitering Tools
B8 Performance Menitor

QB

: ance or = |
@ File Action View Favorites Window Help ||T||E|m
|E e | H

E= Reliahility Monitor

| Unfreeze Display (Ctrl+F) ”L

[ 3 Data Collector Sets 100
[ :ﬁ Reports
50
0 T .
2:02:03 PM 2:02:35 PM 2:03:05 PM 2:03:42 PM
Last | 23438 Average | 18950 Minimurm | 1.563
Maximum | 98433 Duration | 1:40
Show Color Scale  Counter Instance Parent  Object Computer

¥ ——10  %ProcesorTime Total -~ Processor  \UOHN-PC

Step 15
Close all open windows.
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Step 16
Navigate to the “Administrative Tools” window by clicking Start > Control Panel >

Administrative Tools. Double-click the Computer Management icon.
If the “User Account Control” window appears, click Continue.

(==
@C)v| v Control Panel » Administrative Tools - |¢f | | Search L |
‘ Organize ¥ BB Views ~ [B Open (& Bumn
Ervaniclinks Name Date modified Type Size
1 — = ?

E| Documents I' | |EE 4 e
E Pictures Ewl u‘ it \_’-::I
B Music Computer ~ Data Sources Event Viewer i5CSIInitiator Local Memory Print Reliability

N a 3 Management  (ODBC) Securi... Diagnosti.. Management and Perfor...
& Recently Changed

o o ey :
Searches - .|I ‘.l_

)l Public . I J

. lil i
Services Systemn Task Windows
Configurat..  Scheduler  Firewall wi...
Folders ~
. | Computer Management Date modified: 1/20/2008 7:43 M
.& ! Shertcut Size: 1.65 KB
L= Date created: 11/2/2006 5:54 AM

Step 17
The “Computer Management” window appears. Expand the three categories by clicking

on the arrow next to: System Tools, Storage, and Services and Applications.

E=8 Eol =)

;gi Computer Management
File Action View Help

= |E = BE

A Computer Management (Local) Mame Actions
A ffi %ﬁtemTools 'Ef& System Tools Computer Management (Lo.. «
[ Task Scheduler g
[ @ Event Viewer :&Storage Maselictidns ,
Ty Services and Applications

[ @] Shared Folders
[ .k,- Lecal Users and Groups
[ @ Relizbility and Performance
i Device Manager
4 23 Storage
=¥ Disk Management
4 :::-':4 Services and Applications
T Services

&5 WMI Control

4 m S
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Step 18
Click the arrow next to Event Viewer then click the arrow next to Windows Logs. Click
System.

;{- Computer Management =1
File Action VWiew Help
== 5
(& Computer Management (Local | ) Date and Time Source EventID Task Category = | | Actions
a |7} System Tools . . [ | system -
E @ Taak Schadiilér @Infﬂrmatmn 7/28/2009 2:34:18 PM Service Cont... 7040 Mone ¥
3
B Bt Vi (i) Information 7/28/2000 2:34:06 PM Service Cont... 7036 Mone /% Open Saved Log..
d Custom Views @Informatlon 7/28/2009 2:33:53 PM Service Cont... 7036 MNone W Create Custom View...
[ Windows Logs @Inforrﬂat!on 7/28/2008 2:33:52 PM Serv!ce Cont... 7036 None Import Custorn View...
& Application (DInformation 7/28/2009 2:33:13 PM Senvice Cont... 7036 Mone
£ Security (i) Information 7/28/2009 2:33:13 PM Service Cont... 7036 Mone ClearLog..
F setup (Dinformation 7/28/2009 2:33:13 PM Service Cont.. 7036 MNone F  Filter Current Log...
] System @Informatlon 7/28/2009 2:33:13 PM Service Cont... 7036 MNone [ Properties
=] Forwarddd Even (D1nformation 7/28/2009 2:32:53 PM Service Cont... 7040 Mone
1 [ Applications and Se @Inforrﬂation 7/28/2009 2:32:45 PM Service Contu, 7036 Mone @ Find..
|:4 Subscriptions (i) Information 7/28/2009 2:32:44 PM TBS 537 MNone <| | save Events As...
I+ @] Shared Folders
- Event 7040, Service Control Manager Eventlog Provider x Attach a Task To this L.
- & Local Users and Groups
+ @ Reliability and Perform | [ General | Details View :
4 Device Manager 6] Refresh
4 23 Storage = =
g tORAC [The start type of the Routing and Remate Access service was changed from demand start to H Hep »
= Disk Management disabled.
& Fy Services and Applications Event 7040, Service Control ... =
[£] Event Properties
] Attach Task To This Ev...
Log Name: System 5z Copy L
Source: Service Control Manager Eve Logged: 7/28/2009 2:34:18 PM [ Save Selected Euents..
Event ID: 7040 Task Category: None & Refresh
Level: Information Keywords: Classic Help »
User: Jehn-PC\John Computer: John-PC
OpCode: Info
More Information:  Event Log Online Help
] m b

Double click the first event in the window.

A Computer Management
File Action View Help

b e s

& Computer Management (Lecal [ | _ ) Date and Time Source EventID Task Category = | | Actions
4 {f} System Tools — @[,
% Service Cont 7040 None —I| | System &
i (5 Task Scheduler
I g Event Viewer @Informatlon 7/28/2009 2 Service Cont, 7036 MNone = Open Saved Log...
» BB Custom Views @Im’ormation 7/28/2009 2:33:53 PM Service Cont.., 7036 None ¥ Create Custom View...
4 [ Windows Logs ®Inf0rmation 7/28/2009 2:33:52 PM Service Cont... 7036 None g ke
{2 Application (i) Information 7/28/2009 2:33:13 PM Service Cont... 7036 Nene
£ security (i) Information 7/28/2009 2:33:13 PM Service Cont... 7036 MNone Clear Log...
£ setup (i) Infermation 7/28/2009 2:33:13 PM Service Cont... 7036 Nene T Filter Current Log...
f=] System (i) Infermation 7/28/2009 2:33:13 PM Service Cont... 7036 Nene B Proparties
5] Forwarded Even @Informatlon 7/28/2009 2:32:53 PM Service Cont... 7040 MNone
1 [ Applications and Se||| (i) Information 7/28/2009 2:32:45 PM Service Cont... 7036 MNone 88 Find..
[ Subscriptions () Information 7/28/2008 2:32:44 PM TBS 537 Mone ~| |k SaveEventss..
I» @] Shared Folders .
- Event 7040, Service Control Manager Eventlog Provider x Attach  Task To this L.

i+ # Local Users and Groups

b @ Reliability and Performé| | ["General [ petails View »

% Device Manager |G Refresh

=
4 55 Storage The start type of the Routing and Remote Access service was changed from demand start to Hel 4
o P g 9 P
=5 Disk Management disabled.
:j_)g Services and Applications Event 7040, Service Control ...

[E] Event Properties
] Attach Task To This Ev...

Log Name: System Bz Copy 4
Source: Service Control Manager Eve Logged: 7/28/2009 2:34:18 PM [ed Save Selected Events...
Event ID: 7040 Task Category: None |G Refresh

Level: Information Keywords: Classic Help N
User: John-PC'ohn Computer: John-PC

OpCode: Info

More Information:  Event Log Online Help
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The “Event Properties” window appears for the event. Click the down arrow key to locate
an event for Routing and Remote Access.

12] Event Properties - Event 7040, Service Cantrol Manager Eventlog Provider =
General | Details
The start type of the Routing and Rermote Access service was changed from demand start to
disabled.
4+
Log Mame: Systern
Source: Service Control Manager Eve Logged: 1/28/2009 2:34:18 PM E
Event ID: 7040 Task Category: Mone
Level: Information Keywords: Classic
User: John-PCWohn Computen John-PC
OpCode: Info
Maore Information:  Ewvent Log Online Help

Step 19
You should find four events that describe the order for starting and stopping the Routing
and Remote access service.
Write down the description for each of the four events.

@ Event Properties - Event 7040, Service Control Manager Eventlog Provider @
General | Details
The start type of the Routing and Remote Access service was changed from disabled to demand
start.
Log Name: System
Source: Service Control Manager Eve Logged: 7/28/2009 2:32:53 PM [E
Event ID: 7040 Task Category: Mone
Level: Information Keywords: Classic
User: lohn-PChJohn Computer: John-PC
OpCode: Info
More Information:  Event Log Online Help
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Q Event Properties - Event 7036, Service Control Manager Eventlog Provider

General | Details

The Routing and Remote Access service entered the running state.

Log Name: System

Source: Service Control Manager Eve Logged: 7/28/2009 2:33:13 PM
Event ID: 7036 Task Category: Mone

Level: Information Keywords: Classic

User: MN/A Computer: John-PC

OpCode: Info

More Information:  Event Log Online Help

[« &

Cloze

12 Event Properties - Event 7036, Service Control Manager Eventlog Provider

General | Details

The Routing and Remote Access service entered the stopped state.

Log MNarme: System

Source: Service Control Manager Eve Logged: 7/28/2009 2:34:06 PM
Event ID: 7036 Task Category: Mone

Level: Information Keywords: Classic

User MN/A Computer: John-PC

OpCode: Info

More Information:  Event Log Online Help

[¢] [

Close
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@ Event Properties - Event 7040, Service Control Manager Eventlog Provider @
General | Detaile
The start type of the Routing and Remote Access service was changed from demand start to
disabled.
+
Log MName: System
Source: Service Control Manager Eve Logged: 1/28/2009 2:34:18 PM E]
Event ID: 7040 Task Category: Mone
Level: Information Keywords: Classic
User lohn-PCWJohn Computern: John-PC
OpCode: Info
More Information:  Event Log Online Help

Step 20
Close all open windows.

Step 21
Navigate to the “Run” window by clicking Start > Run. Type MMC and click OK.
f the “User Account Control” window appears, click Continue.

o o)

=7 Run ==

=== Typethe name of a prograrm, folder, document, or Internet
resource, and Windows will open it for you.

Open: mimec -

oK L\FH Cancel | | Browse.
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Step 22

The “Consolel [Console Root]” (console number may vary) window appears.

Consolel - [Console Root] | o] =]
File Action View Favorites Window Help & =
= H
| Console Root Marne Actions
A 6 B Console Root -
There are no items to show in this view.
Mere Actions 4

Step 23

To build your own custom console click File > Add/Remove Snap-in. The “Add or
Remove Snap-in” window appears.

Add or Remove Snap-ins

=)

You can select snap-ns for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins;

- )

Snap-n Vendor s
Microsoft Cor...
; Microsoft Cor,..
G Certificates Microsoft Cor... |2
N Component Services Microsoft Cor,..
n'é' Computer Managem... Microsoft Cor...
&= Device Manager Microsoft Cor...
1= Disk Management Microsoft and...
Q Event Viewer Microsoft Cor...
| Folder Microsoft Caor...
_.: Group Policy Object ... Microsoft Cor...
@ IP Security Monitor Microsoft Cor...
g IP Security Policy M...  Microsoft Cor...
[Z|Link to Web Address ~ Microsoft Cor...  _
= Lo .
Description:

Selected snap-ns:

| Console Root

Edit Extensions...

Remove

The ActiveX Control snap-in enables you to add an MMC node with a results view containing an ActiveX control.

[ 0K ] ’ Cancel

© 2007-2010, Cisco Systems, Inc. All rights reserved.
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To add a folder snap-in so that you can organize all your snap-ins, scroll down until you
see the Folder snap-in. Select Folder > click Add.

Add or Remove Snap-ins =

You can select snap-ns for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins; Selected snap-ns:
Snap-n vendor - | Console Root Edit Extensions. ..
=" ActiveX Control Microsoft Cor... R
Aumorizat’on Manager Microsoft Cor...
[ Certificates Microsoft Cor... |E
. Component Services  Microsoft Car... Move Up
n'é'- Computer Managem... Microsoft Cor... :
; . " Move Down
g=n Device Manager Microsoft Cor... add
=
1= Disk Management Microsoft and... q
@ Event Viewer Microsoft Cor...
:I Microsoft Cor...

\=f Group Policy Object ... Microsoft Cor...
g IP Security Monitor Microsoft Cor...
g IP Security Policy M...  Microsoft Cor...

%, Link to Web Address ~ Microsoft Cor...  _

Description:

The Folder snap-in adds a folder node to the tree. This can be used to organize your snap-in console,

[ OK ” Cancel ]

To add the “Link to Web Address” snap-in, scroll down until you see the snap-in. Select
Link to Web Address > click Add. The “Link to Web Address” wizard opens. In the
Target box type http://www.cisco.com/. Click Next.

Link to Web Address (]

Welcome to the Link to Web Address
Wizard

The Link to Web Address snap-in consists of an MMC
node with a Web page in the results view. Type the

path or URL for the site you want to display, or dick
Browse.

Path or URL:

http: f{fwww . dsco.com

Browse...

< Back NEH}D\S!] [ Cancel
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In the “Friendly name for the Link to Web Address snhap-in” box type Cisco. Click Finish.

Link to Web Address

Friendly name for the Link to Web Address snap-in:

=3

Cisco

< Back ][ Finish%‘l ’ Cancel

Step 24

To add snap-ins to the folder snap-in, click Advanced.

Add or Remove Snap-ins

Available snap-ins:

Snap-in Vendor gt
17 ActiveX Control Microsoft Cor. ..
Authorization Manager Microsoft Cor...
:ﬁ]l Certificates Microsoft Cor... |=
A Component Services Microsoft Cor...
“é'-Compuber Managem... Microsoft Cor...
=4 Device Manager Microsoft Cor...
=¥ Disk Management Microsoft and. ..
Q Event Viewer Microsoft Cor. ..
“| Folder Microsoft Cor. ..
'=[ Group Policy Object ... Microsoft Cor...
.g IP Security Monitor Microsoft Cor. ..
g IP Security Policy M...  Microsoft Cor...
2] Link to Web Address ~ Microsoft Cor...  _
= .. o ... .
Description:

==

‘fou can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Selected snap-ns:

“| console Root Edit Extensions...

[ Folder

8] i Remove
=i [ Remoe |

o
L
]

Move Down

L

The Folder snap-in adds a folder node to the tree. This can be used to organize your snap-in console.

Cancel

o
=

Click in the box next to Allow changing the parent snap-in. Click OK.

Advanced

By default, snap-ins are added under the console root node. Selecting this chedk box
enables you to choose the parent snap-in under which snap-ins will be added.

Allow changing the parent snap-in

5

[ oK Dy‘J[ Cancel
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A dropdown menu appears for “Parent snap-in”. In the “Parent snap-in” box select
Folder.

Add or Remove Snap-ins (3]

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled,

Available snap-ins: Parent snap-in:
Snap-in Vendor h [ | Folder v]
~ | ActiveX Control Microsoft Cor... I ~| Console Root

H “THOaEr
-#: Component Services  Microsoft Cor...

:‘é‘ Computer Managem... Microsoft Cor... o
24 Device Manager Microsoft Cor... — -
=% Disk Management Microsoft and... - fone iy

@ Event Viewer Microsoft Cor...

| Folder Microsoft Cor...
_'ib." Group Policy Object ... Microsoft Cor...
.g IP Security Monitor Microsoft Cor...
.g IP Security Policy M...  Microsoft Cor...

.:;. Link to Web Address ~ Microsoft Cor...  _

Description:

The Link to Weh Address snap-in enables you to add an MMC node with a Web page in the resulis view,

Add these snap-ins: Computer Management, Device Manager, and Disk Management.

Note: When asked what computer the snap-in will manage; select the default by clicking
Finish.

Click OK to accept all changes.

Add or Remove Snap-ins =)

‘fou can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ing, you can configure which extensions are enabled.

Available snap-ins: Parent snap-in:

Snap-in Vendor i | Folder - ]

[
ActiveX Control Microsoft Cor... ‘

i

Selected snap-ins:
uthorization Manager Microsoft Cor...

L "I console Root Edit Extensions...
M Certificates Microsoft Cor... |=|

§ | Folder
s Component Services  Microsoft Cor... ‘

i'é‘ Computer Managem... Microsoft Cor...

4 Device Manager Microsoft Cor... ‘é' e amoemen), foc

=¥ Disk Management Microsoft and. .. ) :(,::-i-::)ewce fe My

@ Event Viewer Microsoft Cor... = e B
_|Folder Microsoft Cor...

_'.=~.' Group Policy Object ... Microsoft Cor...

.g IP Security Monitor Microsoft Cor...

.g IP Security Policy M...  Microsoft Cor...

= Link to Web Address  Microsoft Cor...  _ Pl — ] b
— e . A

Description:

‘You can use Device Manager to view a list of hardware devices installed on your computer and set properties for each device,

[ oK L\@J[ Cancel
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Step 25
The “Consolel” window appears. Right click the Folder icon and select Rename. Change
the name of the folder to ManagementTools.

E Consolel - [Console Root] EI@
File Action View Favorites Window Help -[&| %
9|3 = H
| Console Root MName Actions
4 B Mana.gmentTools = Managment Tools Console Root i
- = Disk Management(Loca = Cisco More Actions 2

» (A Computer Managemend
> ﬁ Device Manager on loca

=1 Cisco
=l

To save the custom console click File > Save As. Change the file name to your name.
Example: John’s Console. Change the “Save in” box to Desktop. Click Save.

Step 26
Close all open windows.

On the desktop double click the Console icon to re-open the console with your snap-ins.
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